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The College of Arts and Sciences Web site is based on templates that help give site maintainers a

starting point for developing Web pages. This handout will go over the uses of these templates, how

to modify the content on pages using Adobe Contribute, how to modify the navigational items on
your pages, how to edit your faculty and staff directory entries, and how to add items to the news
and/or events to the landing page of your site (if applicable).
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SITE GOALS

The College of Arts and Sciences Web site is intended to showcase the achievements of the students,
faculty, and departments of the College of Arts and Sciences. The entire site is divided into two distinct
areas: 1) the College and 2) its departments. The main Web address for the College is the following:

http://www.sandiego.edu/cas/

Departmental sites are available from the Quick Links region of the CAS home page under the
Department, Major, or Minor headings.

The College Web site area is made up of this primary entry point and any content that bridges all
departments and centers, such as Admissions, News/Events, Giving, etc. Meanwhile departments each
have the ability to customize one of four home page templates. Although typography and layout have
been defined, photography, messaging and creative uses of the templates will allow each department
to showcase their unique personality. Sub-pages will be unified for all departments, yet a flexible and
open design has been created to allow for a wide variety of text, imagery, and data.

The Web site’s design is structured to show visitors the diversity of academic programs, majors and
minors offered by the College of Arts and Sciences. The site will be a rich source of information about
the academic opportunities and achievements of the College.

All photography on the site must include people that identify with the College and academic life on
campus at USD. Striking, professional images are encouraged, often with a youthful passion for
education and academic excellence. The imagery should identify with USD and the communities
around San Diego. Show the beauty of the campus and the variety of buildings connected with the
College. Faculty, administration, and staff should be photographed on campus in natural light, not
with a staged backdrop. Embrace the academic life and candid experiences encountered between
students and faculty.
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CAS TEMPLATES

The CAS Web site is structured via two content templates and seven departmental home page
options.

CONTENT TEMPLATES

Content templates are used for sub-pages of the Web site for displaying text, images, and other data.
Main Content Template

The CAS Web site has a content page for all pages in the main (i.e. non-departmental) parts of the site.
The main content template has the following editable regions:

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS: Section:
Topic.

o Title: The title is the heading of your page. For example, Academics, Contact Us, etc.

o Main Content: Input your main content here. This can contain text, photos, links, etc.
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To see this template in use, please visit the following pages:

http://www.sandiego.edu/cas/about/
http://www.sandiego.edu/cas/academics/
http://www.sandiego.edu/cas/faculty/
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Departmental Content Template

This template is meant for all departmental content pages of the CAS Web site. The department
content template has the following editable regions:

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS:

Department: Topic.
o Title: The title is the heading of your page. For example, Academics, Contact Us, etc.
o Main Content: Input your main content here. This can contain text, photos, links, etc.
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To see this template in use, please visit the following pages:

http://www.sandiego.edu/cas/art/student_work.php
http://www.sandiego.edu/cas/liberal/slb/biographies.php
http://www.sandiego.edu/cas/theo/alumni/alumni_news.php
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HOME PAGE TEMPLATES
Home page templates are available to serve as the basis for all departmental home pages.

A1 Landing Page Template

This template is a departmental home page option for the CAS Web site. The template is intended for
diverse content with longer introductions. Right-hand modules are optional for news, events, faculty
essays, and resources.

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS:
Department: Topic.

o Banner: Choice of 1, 3, or 5 primary photos to represent department. Photos should be
selected by the department and then cropped and placed by a member of the Web Services
team in Information Technology Services.

o Main Content: Input your main content here. This can contain text, photos, links, etc.

o Profile: Optional region for videos and photos. If no content is inserted into this region, then
the region will not be visible online when you publish the page.
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To see this template in use, please visit the following pages:
http://www.sandiego.edu/cas/polisci/
http://www.sandiego.edu/cas/theo/
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A2 Landing Page Template

This template is a departmental home page option for the CAS Web site. The template is intended for
diverse content with longer introductions.

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS:
Department: Topic.

o Banner: Choice of 1, 3, or 5 primary photos to represent department. Photos should be
selected by the department and then cropped and placed by a member of the Web Services
team in Information Technology Services.

o Main Content: Input your main content here. This can contain text, photos, links, etc.

o Profile: Optional region for videos and photos. If no content is inserted into this region, then
the region will not be visible online when you publish the page.
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To see this template in use, please visit the following pages:
http://www.sandiego.edu/cas/anthropology/
http://www.sandiego.edu/cas/asianstudies/
http://www.sandiego.edu/cas/math-cs/
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B1 Landing Page Template

This template is a departmental home page option for the CAS Web site. The template is intended for
highly compelling photos and limited content. Two module windows are available for news, events,
faculty essays, and resources.

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS:
Department: Topic.

o Main Content: One-paragraph introductory statement about the department limited to 52
characters or fewer.

o Image Areas: Choice of 4 primary photos to represent department. Photos should be selected
by the department and then cropped and placed by a member of the Web Services team in
Information Technology Services.
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To see this template in use, please visit the following pages:

http://www.sandiego.edu/cas/commstudies/
http://www.sandiego.edu/cas/phil/
http://www.sandiego.edu/cas/sociology/
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B2 Landing Page Template

This template is a departmental home page option for the CAS Web site. The template is intended for
highly compelling photos, limited content, and extended navigation.

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS:
Department: Topic.

o Main Content: One-paragraph introductory statement about the department limited to 52
characters or fewer.

o Image Areas: Choice of 5 primary photos to represent department. Photos should be selected
by the department and then cropped and placed by a member of the Web Services team in
Information Technology Services.

o Program Areas: Intended for additional vertical navigation not included in primary horizontal
navigation.
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To see this template in use, please visit the following pages:

http://www.sandiego.edu/cas/graduate/
http://www.sandiego.edu/cas/languages/
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C1 Landing Page Template

This template is a departmental home page option for the CAS Web site. The template is intended for
large singular imagery with frequent news and events. An alternating modular window is available for
news, events, faculty essays, and resources.

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS:
Department: Topic.

o Banner: Choice of primary photo to represent department. Photo should be selected by the
department and then cropped and placed by a member of the Web Services team in
Information Technology Services.

o Main Content: One-paragraph introductory statement about the department limited to 42
words or fewer.
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To see this template in use, please visit the following pages:
http://www.sandiego.edu/cas/honors/
http://www.sandiego.edu/cas/humanities/
http://www.sandiego.edu/cas/music/
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C2 Landing Page Template

This template is a departmental home page option for the CAS Web site. The template is intended for
large rotating imagery with frequent news and events. Two modular windows are available for news,
events, faculty essays, and resources.

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS:
Department: Topic.

o Banner: Choice of primary photos to represent department which can toggle/rotate with brief
accompanying text supplement. Photos should be selected by the department and then
cropped and placed by a member of the Web Services team in Information Technology
Services.
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To see this template in use, please visit the following page:

http://www.sandiego.edu/cas/chemistry/
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D1 Landing Page Template

This template is a departmental home page option for the CAS Web site. The template is intended for
showcasing events, accomplishments, and faculty/student work via an oversized photography
slideshow.

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS:
Department: Topic.

o Featured Area: Comprised of oversized image with accompanying scrolling text. Photos
should be selected by the department and then cropped and placed by a member of the Web
Services team in Information Technology Services.

PROGRAMS FACULTY CouRSES STUDY ABROAD STUDENT WORK ALUMA GIVING =

To see this template in use, please visit the following pages:

http://www.sandieqgo.edu/cas/art/
http://www.sandiego.edu/cas/theatrearts/
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D2 Landing Page Template

This template is a departmental home page option for the CAS Web site. The template is intended for
showcasing events, accomplishments, and faculty/student work via an oversized photography
slideshow. A fading black “curtain” is available on the left and right sides of the screen.

o Page Title (not pictured): Enter the title of your page here in the format USD: CAS:
Department: Topic.

o Featured Area: Comprised of oversized image with accompanying scrolling text. Photos
should be selected by the department and then cropped and placed by a member of the Web
Services team in Information Technology Services.
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To see this template in use, please visit the following pages:

Not currently in use on the CAS Web site

USD Web Design 11 ITS
CAS Web Site usD



CONTRIBUTE

Adobe Contribute is the software you will use to maintain pages within your departmental site.
CONNECTING CONTRIBUTE
You will be connected to the CAS Web site in Contribute by your CAS Web developer or a member of

the ITS staff. If at any point you become disconnected from your site, please contact
websupport@sandiego.edu for assistance.

GETTING STARTED

Generally you will use Contribute to make additions or modifications to the content portions of your
Web pages. You can insert images, add text and position page contents using tables.

Your site creation/maintenance process will consist of modifying content on already existing pages.

From the Contribute Start Page, click on your Web site name under the Begin Editing heading.

Ct

ADOBE" CONTRIBUTE' CS3
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You should always see the landing page of your site when you begin editing. Typically you will want to
modify content on your site.
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Modifying Pages

Contribute allows you to modify already existing pages as well as delete files you no longer need in
your site. You can modify any page in your area of the Web site by browsing to it and editing.

USD: CAS: Fine Arts: Visual Arts & Art History Courses

d‘ New ... = Back () Stop |G| Refresh /;\Lvl'omc Pages [Zigt

Address:  http://www.sandiego.edu/cas/finearts/courses/index.php

To modify a page in Contribute, navigate to it via the Contribute browser or enter a URL directly into
the address bar. Click on Edit Page to view your page in edit mode so that you can begin making
changes. When completed, you can send for review, save for later, or delete to discard your changes
as usual. These options are discussed in the Publish Options section of this handout.
+ Tip: Note that discarding changes does not delete the actual file; to learn about deleting
files, please see the section on Deleting Pages.

Creating a New Page

If your goal is to make a new page, navigate to the section of your Web site where you would like to
add a new page and click on New... in the toolbar menu bar to begin.

USD: CAS: Fine Arts: Visual Arts & Art History Courses

’ Edit Page Q:\_) Back nj(: Stop |G| Refresh /vab4omc Pages [Zigt

Address:  http://www.sandiego.edu/cas/finearts/courses/index.php

Select the content_department template option for all sub pages on your site. This template has a
content region that makes use of 100% of the space for text, images and any other desired content.
This template is aimed toward information.

The Preview pane on the right will also show a quick preview of the template.

New Web Page o Blog Entry

Create new web page o blog entry for Prevaw

Cruate & pew wod page bawed on thin template.
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In this same window, you will be prompted for the title of your Web page. Note that Contribute will
not let you continue unless you enter a title. This should be structured as follows:

USD: CAS: Department: Topic

«» Tip: The title is what will display in the Bookmarks bar when someone bookmarks the
page in their browser.

Page title: USD: CAS: Art: Architecture
( Cancel ¢—ok

Click OK and you will see your new page in edit mode. If you need to go back and edit a page title
after you have begun working on your new page, you can go to Format > Page Properties >
Title/Encoding to do this.

WORKING WITH CONTENT
You can use the Contribute toolbar to format your content, insert links, insert images and insert tables

for positioning your content items. You can also use Contribute to spell check your text for a final
review before publishing your content to the Web.

27 Publish 5= Send for Review 7' Save for Later 3 Discard Draft : ==-] Link 4| Image Table
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Formatting Text

You will only be able to work within the designated editable regions of your page. This means staying
within the content bounds provided by the templates.

To insert text, you can copy and paste data and information from other applications such as Microsoft
Word and Corel WordPerfect, or you can simply begin typing. You can then format the text by styling
it (bolding or italicizing), aligning it (left, center, right, or fully justified), creating lists (bulleted or
numbered) or by indenting.

s Tip: If you are inserting sections of information in your content, separate them with section
headings (i.e. Heading 1, Heading 2, etc.) by highlighting the word and selecting the
appropriate heading from the Normal menu. In addition to making your content easier to
read, it will also help your search engine rankings since headings are more “important” than
normal text. The heading tags are usually numbered from one to six, with one being the most
important.

70 Publish = 7= Send for Revig

Normal M B 7
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Inserting Links

A hypertext link, often called a link, creates a connection from one page to another page. In a Web
page, links are typically underlined and differentiated by color from the surrounding text. When a
visitor to your site clicks a link in one page, another page opens.

Contribute lets you add the following types of links from the Link button in the toolbar:

r ol Jueks 3F  Image fabie
Drafts and Recent Pages...
Create New Page...

Browse to Web Page...

E-mail Address...
File on My Computer...

o Draft and Recent Pages

You can create a link on your page to a draft that you are currently editing or to a recently published
page on your site. Contribute has a complete list of current drafts for you to link to, and stores a list of
the last ten pages you published on your site.

To create a link to a draft or recently published page on your site, you must first indicate where the link
will appear by placing the insertion point in the draft, selecting text in the draft, or selecting an image
in the draft. Click Link > Draft and Recent Pages and complete the dialog box by selecting the
desired draft and clicking OK.

o Create New Page

You can create a link to a new Web page on your site—that is, you can create a link to a new page that
Contribute creates at the same time that it creates the link. Contribute lets you create the new page
and link to it before you add content to the page.

To create a link to a new page, select text in the draft or select an image in the draft. Click Link >
Create New Page and complete the dialog box. Click OK and Contribute adds the link to the draft,
and then opens the new page in the Contribute editor. To return to the draft where you added the
link, click the draft title in the Pages panel.

o Browse to Web Page

You can create a link to another page on your Web site or on another site. Contribute enables you to
use the file system to find the page.

In your draft, you will need to indicate where the link will appear by placing the cursor at an insertion
point, selecting text, or selecting an image. Click the Link > Browse to Web Page and browse to the
page you are seeking to link. Likewise you can type in any URL for external sites not within the CAS
Web site. Complete the dialog box and click OK. Contribute adds the link to your draft in your desired
location.
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o E-mail Address

You can create a link to an e-mail address so that when a visitor clicks the link, Contribute opens a new
blank message, addressed to the e-mail address you specified, in the visitor's default e-mail
application.

For example, you might write "Contact us about our programs” and link this to the department’s e-
mail address. When a visitor clicks the link, the browser will open the visitor's e-mail application and
creates an e-mail message to the address.

In your draft, you will need to indicate where the link will appear by placing the cursor at an insertion
point, selecting text, or selecting an image. Click the Link = E-mail Address option, complete the
dialog box, and click OK. Your new link is now added to the page.

o File on My Computer

You can also create a link on your page to a file saved on your computer. For example, you might link
to a PDF document saved on your hard drive; note that PDFs should be named succinctly for the Web
when created on your computer (e.g. “award_honors.pdf” rather than “who got awards at the event
on 12/2/07.pdf"). When you publish the page with the link, Contribute copies the file into your Web
site and then links to that on your site. That way, when someone clicks on your PDF link online, the
visitor will be able to view it or save it to his/her system.

In your draft, you will need to indicate where the link will appear by placing the cursor at an insertion
point, selecting text, or selecting an image. Click the Link > File on My Computer option, complete
this dialog box, and click OK. Contribute copies the file and a link to the new file appears in your draft.

Optimizing PDF Files
Optimizing your PDF files can reduce your file sizes to a tenth or less of the original. This will make

your pages download ten or more times as fast. You will need Adobe Acrobat software
(Windows/Macintosh) or Preview (Macintosh) for optimizing PDFs.

Bring any PDF into Acrobat and File > Save As. As you are saving make sure the Format is set to
Adobe PDF Files, Optimized.

You can also bring a PDF into Preview on Macintosh and File = Save As. As you are saving make sure
the Quartz Filter is set to Reduce File Size.

Inserting Tables

A table is a tool for presenting data or for page layout. You can create tables with a border of “0” (no
border) and format content so that the table does its job without being visible to visitors.

You can insert a table anywhere on a page. To begin, place the insertion point in your draft where you
want the table to appear. Click the Table button in the toolbar.

The Insert Table dialog box appears, and you'll enter your table specifications here, such as the
number of rows and columns. If you do not want the table border displayed when the page is live,
make sure to set border thickness to “0”".

Click OK and the table appears in your draft. After you create a table, you can easily modify both its
appearance and structure by right-clicking on the table and choosing Table Properties.
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Formatting Tables

Pre-formatted tables are also available in Contribute to help enhance the design of tables on your site.
After your initial table has been inserted, select the table and choose Table > Format Table from the
menu area. AltRows:Basic Grey is the preferred color style for the CAS Web site, which will color
alternating rows with a light grey color and therefore make the content in your table easier to read for
visitors.

Spell Check

It's a good idea to use the Check Spelling command to check the spelling in your draft after you add
or edit text. To check and correct spelling, select Format > Check Spelling.

If Contribute encounters an unrecognized word, the Check Spelling dialog box appears. Select the
appropriate option based on how you want Contribute to handle the discrepancy. Click OK after
finishing this task.

WORKING WITH IMAGES

Imagery is a significant part of the CAS Web site, and is a perfect way to show glimpses into life at the
College, distinguish one department from another, or simply to add color to a page.

Choosing Photography
When using photo images in the CAS Web site, here are some things to consider:

* Always use photography that is appropriate to the section. Never enlarge low-resolution
images

Never stretch or distort image dimensions

Photos of people should be cropped at the individual’s shoulders so the face is recognizable

If using stock photography, images must have proper licensing

If embedding a photo/image within a text sub page (for example the About College sub page),
do not extend photos beyond a maximum width of 300 pixels

* Incorporate campus architecture and elements unique to the College

Portraits
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Don’ts

- " I

Low Resolution Stretched/Squashed Wrong Cropping

Inserting Images

You can use the Insert menu or Image button in the toolbar to add an image from your computer or a
Web site to a page.

To add an image using the Insert menu or Image button, place the insertion point in your draft where
you want the image to appear. Click the Image button in the toolbar. Select one of the following
options from the pop-up menu:

*  From My Computer: lets you browse to an image on your computer
* From Website: lets you browse to the main images folder in the CAS Web site for images
* From Internet: please ignore, we are not using this option on the CAS Web site

Choose the desired image from the Web or your computer and then click the Select or OK button.
s Tip: Whenever you insert an image, you will be prompted to enter ALT text, or alternative text.
This should be a brief (one or two word) description of your image. This description will be
visible in the event that your image does not load online. Itis particularly important and
necessary to include ALT tags because they also make your pages accessible to disabled
persons visiting your pages.

After you insert your image, double-click the image to change image properties. Image properties
include the location of the image source, display area size, padding, alignment, border and alternate
(ALT) text.
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PUBLISH OPTIONS

Once you've inserted your content and formatted it accordingly, you can publish, send your page for
review, save it for later or cancel the page.

Publish

Publishing your page is another way of telling Contribute to upload your page, which sends your file
and any dependant files (such as images) up to the server and makes your page live on the Web. For
example, any images you've placed on your pages will be put into an images folder on the remote
server by Contribute. Note that the Publish option is not available for some roles on the CAS Web
site.

7% Publish 7% Send for Review ' Save for Later  $¢ Discard Draft =7 _ Link

Normal B 7/ i S=EEE =i

[
I

Send for Review

Once you have made changes to your page, you will need to Send for Review in order to collaborate
with others on your content and have your draft published.

2 Send for Review ) 7/ Save for Later = $€ Discard Draft &,

EEEEE L =

Selecting this option will display a list of all maintainers on the CAS Web site. You can send your draft
to other members of your department for review.

For publishing your file, please send your draft to the Publisher for your department role. If
that person is out of the office, please select the College of Arts and Sciences Publisher role in its
place. Please select to Notify recipients through e-mail and press Send.

Save for Later
If you're not ready to make your new or modified content live, you can Save for Later so that you can

return to do more editing on the page at a later time. Pages saved for later will show up in the left-
hand column of Contribute under the Pages heading.

ANND
o o Py
b _Srowser U BO: CAS: Fime At mclien
A Asse rer
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Discard Draft

And you can also Discard Draft, which means you will discard the page and any content/changes you
have added.

7

+«» Tip: When modifying a page, discarding draft only discards your changes but does not delete
your file. To delete a file, refer to the section on Deleting Pages.

Publisher Role

If you are a publisher on the CAS Web site you will be receiving drafts from others for publication. You
be notified of drafts in two ways:

1. Via an e-mail notification
2. Drafts will be visible in the pages panel

Ao USD. CAS. Fine Arts. Study Act Abeaad

T 50 s P A e A

Study Art Abroad

After reviewing the content, you can publish the draft, make further edits, and/or send for review
again to anyone needed on the site.

FILE NAMES

If you are publishing a page for the first time, you will be prompted to give your page a file name. For
these pages, you will need to use the *.php extension.

Titling file names is very important since the navigation is automatically generated from the file
and folder names.

s Tips:

o Keep file names succinct and without breaks. For example:
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o Good: employers.php
o Good: continuing_education.php
o Bad:how to get a job after usd.php

o File names longer than one word should be separated by underscores. For example:
o contact_us.php
o alumni_association.php

o Acronyms should be capitalized. For example:
o CAS.php

o Any new folders (i.e. containers of one or more files) should be treated the same way, for
example:
o CAS

o Folder or file names should not be dated. For example:
o Good: service_brochure.php
o Bad: service_brochure_1997.php
o This way other Web sites can link to your pages and files and not have broken links when you
upload new versions. This applies to dependent files such as images and documents (PDFs) as
well.

DELETING PAGES
Some roles also have the ability to delete pages on the CAS Web site. You will want to be diligent
about deleting files from the Web site that are no longer in use, since any page within the site will be

displayed in the navigation and be listed in search engine results.

To delete a page, you will need to go to File > Actions > Delete Page.

New uN
Open X0
Browse X0
I ccit Page x

+«» Tip: When deleting a page, remove the appropriate left-hand links as well as any links to the
page that may be in the content regions of the site.
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SEARCH ENGINE OPTIMIZATION

You can associate keywords and a description with your Web pages. Visitors who type one of your
keywords in a search engine will more easily find your page among the search results, since it is more
likely to be toward the top. USD also has its own search engine powered by Google, so your pages will
be more easily accessible on our Web site as well.

To add or change keywords and a description for a page, select Format > Keywords and
Description while you are in edit mode.

Page Keywords and Description

Enter or change keywords in the Keywords pane. Separate each keyword with a comma (for example:
cas, college of arts and sciences, fine art, art, visual arts, art history, architecture, photography).

The Description is a brief summary of the topic of your page. Enter or change the page description in
the Description pane. Click OK when you have one or more descriptive sentences.
¢+ Tip: You can modify your page keywords or description at any time by returning to Format >
Keywords and Description while you are in edit mode.
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NAVIGATION

The College of Arts and Sciences Web Site has a navigation scheme consisting of primary and
secondary navigation. The primary navigation is largely customized on each departmental site, but
retains the following consistent menu items:

* Programs

* Faculty
* Giving
PRIMARY NAVIGATION

S
ALl
; "a”) COLLEGE OF
University

¢SanDiego ARTS AND SCIENCES

PROGRAMS FACULTY COURSES STUDY ABROAD STUDENT WORK ALUMNI GIVING m

The primary navigation provides an easy way for visitors to access the top levels of the CAS Web site.
The primary navigation can be changed or updated by contacting a member of the Web Services
team.

Any content within these links automatically displays within the resulting secondary navigation. For
more information on how links populate the navigation area, please see the next section.

SECONDARY NAVIGATION

The secondary navigation appears directly below the primary navigation and reflects the sub pages in
that section of the Web site.

__’:‘-' COLLEGE OF
2 ARTS AND SCIENCES

FACLLTY COURSES STUOY ABROAD STUDENT WORX ALUMNE GIVING m

The secondary navigation is automatically generated from pages stored within that section of the
Web site.

For example, in the picture above, you are seeing the navigation for the Art department part of the
Web site.

The parent page is Programs. Pages and folders within the Programs section comprise the sub-menu
items.
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ORGANIZING NAVIGATIONAL ITEMS

Generally your navigation structure will represent the files within that part of the Web site. If you

would like to specify which files display in your secondary navigation and in what order you will need

to have a site.list file in that directory. If this file does not already exist for a particular region of the

site, you must talk with the CAS Web Developer to have it added for you. Otherwise all navigation

items display in alphabetical order.

These are the navigation items that drop-down from your primary navigation as well as display in the

left-hand region of your pages.

To edit the sub-navigation of your site, browse to that part of the site in Contribute and type site.list at

the end of the URL.

USD: CAS:

{ Edit Page | New ... = Back (%) Stop G| Refresh A.'

Address: htto:,-‘:www.saﬂdic—go.eda;‘cas;"inc-arts;’p'ogra'n

Contribute will prompt you that this type of file cannot be displayed in the Contribute web browser.

e iat

[ZARE L ’h o) Sisp O Mefre _Home Pge A

site. list

This file cannet e Ssplayed i the Contriite web browser

Press the Edit button to bring up the file in TextEdit (Macintosh) or Notepad (Windows).

7% Pl Send for Revew e for Later 3 Diacand Ovatt o~

ANn ste liat

The site.list file is simply a list of files and folders typed in the order that you would like them to display

in your menu.
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On the left enter the filename or URL. Press Tab on your keyboard and enter the actual link text you
would like to display on your site. In the example above, the navigation reads as follows:

Visual Arts
Art History
Architecture

You could also do the following to change the link text on your site:

architecture.php Architecture
art_history.php Art History

visual_arts.php Visual Arts
/cas/art/study_abroad.php Study Abroad
/cas/documents/art/courses.php Course Schedules
http://www.sandiego.edu/bulletin/  Academic Calendar

/cas/ College of Arts and Sciences

To save, select Save from the File menu and close the TextEdit (Macintosh) or Notepad (Windows)
application. Using Contribute, Publish your updated site.list file.

Art

PROGRAMS FACULTY COuRrses STUDY ABROAD STLOENT|

Programs

View your updated navigation online to confirm that your change has been made.
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FACULTY AND STAFF DIRECTORY

The CAS faculty and staff directory is a comprehensive database-driven system comprised of all faculty
and employees in the College. A management area is available for maintenance of entries which then
display throughout the CAS Web site in a consistent manner and format.

FACULTY AND STAFF LISTINGS

All departments in the CAS Web site have a faculty and staff listing area. For example:

http://www.sandieqgo.edu/cas/art/faculty/

Faculty

‘\;’" '

Listings on each department site are separated into Full-Time Faculty, Adjunct Faculty, and Staff &
Administrators. For interdisciplinary programs there is an Affiliated Faculty listing on the site instead.

MANAGEMENT ACCESS
The CAS faculty and staff directory is managed via the following URL:

http://www.sandiego.edu/cas/manage/directory/

All departmental executive assistants, department chairs, program directors, and the general CAS
administration have access to this resource. This group is called the Super User group. Login is via
your MySanDiego account username and password. If you attempt to log in and do not have access
but should, please e-mail Jim Gump (Qump@sandiego.edu) and Valerie Attisha
(vattisha@sandiego.edu) for approval.

All other users in CAS, upon login, will only have access to editing certain fields of their own
biographies. These fields include:

First Name
Last Name
Title
Secondary Title
Status

E-mail Address
URL

Phone Number

USD Web Design 26 ITS
CAS Web Site usD



e  Fax Number

e Office Location

e Office Hours

All other fields need to be updated by a member of the Super User group.

ADDING AN ENTRY

Those with Super User access can add new faculty and staff members to the system. Click on the link
to Add an Entry to get started. You will then need to complete the form comprised of the following:

Show Online: Whether the individual should display in departmental listings online. If
the person is leaving the university, change from yes - no rather than
deleting the person’s entry from the system.

First Name: Individual’s first name

Last Name: Individual’s last name

Title: Individual’s title

Secondary Title: Individual’s secondary title if applicable

Status: Whether individual is a faculty member, adjunct faculty, visiting faculty,
administrator, or staff. This will direct whether the person displays on a
departmental site’s Faculty, Adjunct Faculty, or Staff page.

Department: Department(s) that individual belongs to. He/she will then display in the
faculty listings on those departmental sites.

Username: Individuals MySanDiego username. Examples are brunetti, gump, or
vattisha. It is important that this information is entered correctly,
otherwise the individual will not be able to log in later and edit their
own entry.

Email: Individual’s e-mail address. Examples are brunetti@sandiego.edu,
gump@sandiego.edu or vattisha@sandiego.edu.

URL: Individual’s professional Web site URL if applicable.

Phone: Individual’s phone number; should be in format (xxx) Xxx-Xxxx.

Fax: Individual’s fax number; should be in format (xxx) XXX-XXXX.

Office: Individual’s office location; should be in format Maher Hall 195

Office Hours: Individual’s office hours.

HTML Fields

The following fields are HTML. Text should not be copied and pasted from Word in order to
avoid styling issues. First copy text into a text editor such as Notepad (Windows) or TextEdit
(Macintosh) and then transfer content into the appropriate area.

Biography:

Brief biography (100 words)

Teaching Interests:

Teaching interests of faculty member (100 words)

Scholarly Work: Scholarly and creative work (150 words)
Education: Education of faculty member (50 words)
Image Fields

The following fields allow an image to be uploaded. Images must first be sized to specified
dimensions and then saved as *.jpg or *.png prior to upload.

Icon: Individual’s headshot saved to 45x56
Thumbnail: Individual’s headshot saved to 89x108
Image: Individual’s headshot saved to 170x184

Document Fields

The following fields allow for document uploads. Documents must first be saved in PDF format
and under 5 MB.

CV: Individual’s curriculum vita

Syllabi: Individual's course syllabi
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MODIFYING CURRENT ENTRIES

Those with Super User access can modify faculty and staff member entries in the system. Others from
CAS logging in will only be able to modify certain fields of their own entry. Click on the link to View
and Modify Entries to get started.

Note that individuals assigned to more than one department display multiple times on the listing
page. Any entry can be updated and changes will be applied in all records.

Click on an arrow to the right of the person’s name that you wish to modify. You will then see an
editable version of the person’s information. Edit as desired and submit changes at the bottom of the
page.

Faculty Directory

arrow % view or meodify e entry

Anthropology

Top Destinstions:

T A A A A A A A

Arabic

First Nazwe Last Namx
Kands Jad-Moueas adjussct faculty -
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INFORMATION POSTING SYSTEM

The Information Posting System is a database that contains news and/or events that are displayed on
the CAS home page, CAS departmental home pages, USD home page, and MySanDiego portal. This is
a Web-based application accessed at the following location:

http://www.sandiego.edu/mypostings/

Using this system you can post news and events to the College home page, department landing
pages, various places on the USD site, and on the MySanDiego portal.

ROUTING ITEMS

In order to route items to the intended pages on the various CAS landing, news, and event pages,
please follow the routing directions below when posting.

* Tip: Interior pages of your sites with news, events, or other types of items can be populated
by selecting “Departmental News & Events” as your destination.
* Tip: The audience for your posting should always be “everyone.”

College of Arts and Sciences @ http://www.sandiego.edu/cas/

College News Category: News
Department: College of Arts & Sciences
Destination: “Featured on Departmental Home Page” if 213x96 image desired,
otherwise “Departmental Home Page”

College Events Category: Event
Department: College of Arts & Sciences
Destination: “Featured on Departmental Home Page” if 124x96 image desired,
otherwise “Departmental Home Page”

Highlights Category: Event
Department: College of Arts & Sciences
Destination: “Highlights (Feature)” if picture desired, otherwise “Highlights”

Dean’s Tweet Updated via Mary's twitter feed at http://twitter.com/deanboyd/

Anthropology @ http://www.sandiego.edu/cas/anthropology/

News Category: News
Department: Anthropology
Destination: Departmental Home Page

Events Category: Event
Department: Anthropology
Destination: Departmental Home Page

Architecture @ http://www.sandiego.edu/cas/architecture/

News Category: News
Department: Architecture
Destination: Departmental Home Page

Events Category: Event
Department: Architecture
Destination: Departmental Home Page
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Biology @ http://www.sandiego.edu/cas/biology/

News

Events

Category: News
Department: Biology
Destination: Departmental Home Page

Category: Event
Department: Biology
Destination: Departmental Home Page

Center for Christian Spirituality @ http://www.sandiego.edu/cas/ccs/

News

Events

Resources

Center for the Study of Latino/a Catholicism @ http://www.sandiego.edu/cas/latino-cath/

News

Events

Category: News

Department: Center for Christian Spirituality

Destination: Departmental Home Page

Category: Event

Department: Center for Christian Spirituality

Destination: Departmental Home Page

Post via http://www.sandiego.edu/cas/manage/resources/

Category: News

Department: Center for the Study of Latino/a Catholicism

Destination: Departmental Home Page

Category: Event

Department: Center for the Study of Latino/a Catholicism

Destination: Departmental Home Page

Chemistry & Biochemistry @ http://www.sandiego.edu/cas/chemistry/

News

Events

Student Highlights

Category: News
Department: Chemistry & Biochemistry
Destination: Departmental Home Page

Category: Event
Department: Chemistry & Biochemistry
Destination: Departmental Home Page

Category: News
Department: Chemistry & Biochemistry
Destination: Highlights

Communication Studies @ http://www.sandiego.edu/cas/commstudies/

News

Events

Faculty Highlights

USD Web Design
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Category: Event
Department: Communication Studies
Destination: Departmental Home Page
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Destination: Faculty Essays

English @ http://www.sandiego.edu/english/

News Category: News
Department: English
Destination: Departmental Home Page

Events Category: Event
Department: English
Destination: Departmental Home Page

Ethnic Studies @ http://www.sandiego.edu/cas/es/

News Category: News
Department: Ethnic Studies
Destination: Departmental Home Page

Events Category: Event
Department: Ethnic Studies
Destination: Departmental Home Page

History @ http://www.sandiego.edu/cas/history/

History Students in Action  Category: News
Department: History
Destination: Highlights

News Category: News
Department: History
Destination: Departmental Home Page

Events Category: Event
Department: History
Destination: Departmental Home Page

Resources Post via http://www.sandiego.edu/cas/manage/resources/

Honors Program @ http://www.sandiego.edu/cas/honors/

News Category: News
Department: Honors Program
Destination: Departmental Home Page

Events Category: Event
Department: Honors Program
Destination: Departmental Home Page

Interdisciplinary Humanities @ http://www.sandiego.edu/cas/humanities/

News Category: News
Department: Interdisciplinary Humanities, Art, Asian Studies, Classical Studies,
English, History, Languages & Literatures, Music, Philosophy, Theatre Arts, OR
Theology & Religious Studies
Destination: Departmental Home Page

Events Category: Event
Department: Interdisciplinary Humanities, Art, Asian Studies, Classical Studies,
English, History, Languages & Literatures, Music, Philosophy, Theatre Arts, OR
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Theology & Religious Studies
Destination: Departmental Home Page

Liberal Studies @ http://www.sandiego.edu/cas/liberal/

News Category: News
Department: Liberal Studies
Destination: Departmental Home Page

Events Category: Event
Department: Liberal Studies
Destination: Departmental Home Page

Marine Science & Environmental Studies @ http://www.sandiego.edu/cas/mars_envi/

News Category: News
Department: Marine Science & Environmental Studies
Destination: Departmental Home Page

Events Category: Event
Department: Marine Science & Environmental Studies
Destination: Departmental Home Page

Activities Category: Event
Department: Marine Science & Environmental Studies
Destination: Clubs & Activities

Medieval and Renaissance Studies @ http://www.sandiego.edu/cas/medren/

News Category: News
Department: Medieval and Renaissance Studies
Destination: Departmental Home Page

Events Category: Event
Department: Medieval and Renaissance Studies
Destination: Departmental Home Page

Music @ http://www.sandiego.edu/cas/music/

News Category: News
Department: Music
Destination: Departmental Home Page

Events Category: Event
Department: Music
Destination: Departmental Home Page

Philosophy @ http://www.sandiego.edu/cas/phil/

News Category: News
Department: Philosophy
Destination: Departmental Home Page

Events Category: Event
Department: Philosophy
Destination: Departmental Home Page

Physics @ http://www.sandiego.edu/cas/physics/
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News Category: News
Department: Physics
Destination: Departmental Home Page

Clubs & Activities Category: Event
Department: Physics
Destination: Clubs & Activities

Resources Post via http://www.sandiego.edu/cas/manage/resources/

Political Science @ http://www.sandiego.edu/cas/polisci/

News Category: News
Department: Political Science
Destination: Departmental Home Page

Events Category: Event
Department: Political Science
Destination: Departmental Home Page

Clubs & Activities Category: Event
Department: Political Science
Destination: Clubs & Activities

Resources Post via http://www.sandiego.edu/cas/manage/resources/

Psychology @ http://www.sandiego.edu/cas/psy/

News Category: News
Department: Psychology
Destination: Departmental Home Page

Events Category: Event
Department: Psychology
Destination: Departmental Home Page

Sociology @ http://www.sandiego.edu/cas/sociology/

News Category: News
Department: Sociology
Destination: Departmental Home Page

Events Category: Event
Department: Sociology
Destination: Departmental Home Page

Clubs & Activities Category: Event
Department: Sociology
Destination: Clubs & Activities

Theology & Religious Studies @ http://www.sandiego.edu/cas/theo/

News Category: News
Department: Theology & Religious Studies
Destination: Departmental Home Page

Events Category: Event
Department: Theology & Religious Studies
Destination: Departmental Home Page
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LOGGING IN

You can log into the system using your MySanDiego (e-mail) username and password.

Immediately you will see a form where you can begin adding your new post. This section will cover
the posting form in its entirety.

THE FORM

General Information

All posts need general information in order for the system to know where to display your post and

what audiences you would like your post to target. More importantly this section of the form captures
basic information such as the type and title of the item.

* | Category: Whether your item is an Event or News item

* Headline/Title:

Title of your post, this is what will be displayed as the headline on the Web

site or in MySanDiego.

USD Web Design
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Department: Your department: to post an item to the main College of Arts and Sciences
home page, select “College of Arts & Sciences”. For all departments please
select your department (refer to routing sheet for more information).

Where to Post: Where you would like the information posted. See Routing Items section
for information specific to the CAS Web site.

Targeted The specific area(s) of the USD community your item applies to. If itis a

Audience: news item or event affecting or inviting everyone, select “Everyone”.

Posting Date

You will need to select a start date and an end date for your post. Based on this information, your item
will display beginning on your selected date and automatically come down when you decide or after
an event has passed. You can post-date items as far into the future as you would like.

* Start Date:

* End Date:

Start Date:

Date that you would like your posting to display on the selected
destination(s) as noted in the previous section.

End Date:

Date that you would like your posting to automatically remove itself from
the USD site or MySanDiego portal. For events, this should be the
same/last day of your event. For news this can be a date of your choosing.

Event Information

If your post is an event, you will need to enter the event logistics for display on the Web site and in the
MySanDiego portal. If you are entering a News item you can bypass this part of the form.

Event Start Date

Evont Start Time

Event End

Evont End Time

Date

Location

Cost

Event Start Date:

Date that your event begins.

Event Start Time:

Time that your event begins.

Event End Date:

Date that your event ends.

Event End Time:

Time that your event ends.

Location: Location where your event will be held.
Cost: Cost of your event. This can either be numerical (e.g. 10.00) or text-based (e.g.
Students: $10; Employees $15).
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Description

The description contains the copy of your news item. Likewise, if posting an event, the entire event
description should be noted in the body. This section of the form also includes other information such
as the sponsoring organization(s) and Web address.

B 7 U
e

Description: Text that will be displayed on the Web or on MySanDiego about your event. If
News this will contain the copy of your item.

Sponsor: Organization that is sponsoring the event or news.

Co-Sponsor: Co-organization that is sponsoring the event or news.

Web Address: The Web address (URL) to your departmental Web site or a page providing
more information about your news or event. This must be in the form
http://www.sandiego.edu/.

Public Contact Information

All posts must have public contact information. This should be the name, e-mail, and phone number
of an employee or representative that the public can call for more information about the posting. If a
contact has already been entered you can simply select his/her name from the drop-down menu.

Pre-Existing Contact

-

* Contact Name I

* Contact E-Mail

* Contact Phone Number ‘

Contact Name: Person that can be contacted for more information.
Contact E-mail: Contact’s e-mail address.
Contact Phone: Contact’s phone number; should be in format (xxx) XXX-Xxxx.
Media
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Any post can have an accompanying image or attachment (PDF) for supplementary information or
reference. Please crop images before posting and do not try to place images directly from a digital
camera, which can be quite a large file size.

Image: Browse... [Please upload a jpeg, jpg, gif or png file.
Attachment: Browse... |Please upload a pdf file.
Image: Image that will accompany your post on the Web site or MySanDiego portal.

Images must have one of the following extensions: .gif, .jpg, or .jpeg. You can
use image editing software such as Adobe Photoshop or GraphicConverter for
optimizing or cropping images.

Attachment: Supplementary file in .pdf format.

Notes

Notes can be included with your post and will not be displayed on the Web site or portal with your
posting. Please address these to the Posting Manager for any special requests or issues.

Notes

Notes: Notes are to be used for special requests or issues and will not be displayed on
the USD Web site or MySanDiego portal.

SUBMITTING YOUR POST

Once you have completed the form, please click “Submit” to send the information you have entered
into the posting system.

You should check your requested destination(s) within 24 hours to see your posting online.
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Please also note that your item may not necessarily be posted to the place(s) you request. For
example, you may request that something be posted to the USD home page. Only 3 items can be
placed on the USD home page at one time.

CAS Home Page (Example)

College Events

ember 28 Jure September J8 - May
S . 4dam 8. 4am

Decomber 24, 12 p.m

MySanDiego Portal (Example)

News o3
Events o3
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AP STYLE GUIDELINES

Please note that all posts are pending review for AP style. All materials published by the University of
San Diego whether print or Web must be written in AP style.

Generally postings submitted to the system will be approved. If there is an occasion where an item is
not approved, the person submitting the post will receive an e-mail with a description of why the item
was refused. In most cases there will be more information or some form of clarification needed, in
which case the poster can work with the Posting Manager to make changes and approve.

The following are general AP style guidelines for reference. A more complete guide can be
downloaded at http://www.sandiego.edu/marketing/identity-writing.php.

Abbreviations

1. Academic degrees. Use the abbreviation Dr. only before the name of a person who holds a
medical degree. Do not use the title Dr. before the names of people who hold other
doctorate degrees or honorary doctorate degrees. In those cases, the degrees should be
listed after the person’s name. (Jane Smith, Ph.D.) All abbreviations of degrees should contain
periods. (B.A., M.A., J.D., LL.M., Ph.D., Ed.D.) Set off academic abbreviations with commas when
used in the middle of a sentence. (Jane Smith, J.D., was the keynote speaker.)

2. Ampersand (&). The ampersand may only be used in the title of the Joan B. Kroc Institute for
Peace & Justice. Do not abbreviate and in any other context.

3. Building names. Do not abbreviate any campus building names except Joan B. Kroc Institute for
Peace & Justice (IPJ) or School of Leadership and Education Sciences (SOLES). You may abbreviate
these when referencing them for a second time in a paragraph.

4. Months. Never abbreviate months when they do not immediately precede a date. (We got
married in September last year.) When the name of a month immediately precedes a date,
abbreviate it, but only if the month's name is six letters or longer. (We met Aug. 6 last year and got
married March 5.)

5. Time. Use a.m. or p.m. Lowercase with periods. Do not use :00 for hour (10 a.m., not 10:00 a.m.)
Avoid redundancies such as 10 a.m. in the morning.

Capitalization
Avoid random capitalization. Do not capitalize for emphasis. Do not use exclamation points.

1. In a headline. Capitalize all words in a title or headline except articles (a, an, the) and prepositions
(of, on, to, at, in). Do not use all caps. (Students Engage in Community Outreach)

2. Of atitle. Capitalize only when they precede a name. (Provost John Smith) Lowercase in all other
instances. (John Smith, provost of the university)

3. Names. Proper names should always be capitalized. Capitalize university when it is part of a
proper name. (University of San Diego) Lowercase in all other references (There are more than
7,000 students at the university.) Lowercase school when referring to more than one of the
university’s schools or when referencing anything other than the formal names of the schools.
(Students applied to the schools of law and business. The student applied to the law school, the
business school and the nursing school. The student will attend the School of Business

USD Web Design 39 ITS
CAS Web Site usD



Administration.) Formal name of a degree is capitalized. (John Smith received a Bachelor of
Science in chemistry.)

4. Church. Capitalize as part of a formal name of a building, a congregation or a denomination. (St.
Mary’s Church, The Roman Catholic Church) Lowercase in phrases where church is used in an
institutional sense. (The church teaches that God is love.)

5. Religious titles. Treat as all titles: spell out and capitalize in front of name. (Father John Smith,
Sister Anne Smith, Monsignor John Smith, Brother John Smith) Exception is Reverend, which is
abbreviated Rev. and always preceded by the. (The officiate was the Rev. John Smith.)

Quotation Marks and Italics

1. Book and magazine titles. Italicize without quotes.
2. Movie titles. Put quotations around title. Do not italicize.

CONTACT FOR POSTING SYSTEM

Please e-mail WebCoordinator@sandiego.edu with any questions, issues or other suggestions you
have in regard to the Information Posting System.
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RESOURCES

The Adobe Web site has helpful guides and streaming video demonstrations on Contribute and other
Adobe products:

o Contribute Documentation: http://www.adobe.com/support/documentation/en/contribute/
o Contribute Support Center: http://www.adobe.com/support/contribute/

For further information about the USD Web site, please see the following internal sites:

o http://www.sandiego.edu/webdev/
o http://www.sandiego.edu/ittraining/
o http://www.sandiego.edu/web/

Please also refer to the IT Training program for classes and drop-in sessions on Adobe Contribute year
round.

o http://www.sandiego.edu/ittraining/
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